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About this manual 

This PRO.FILE manual uses various signs and icons in order to guarantee a good 

readability and comfortable handling. 

For quicker finding within the manual, step-by-step instructions are marked with a 

margin heading. 

Menu sequences and function calls 
Menu sequences and function calls explained in this 

manual are marked in bold and in quotation marks. 

 Example:  

"File" => "New" => 

"Document description" 

Buttons and keys 
Keys and buttons are highlighted by angle brackets. 

 Example:  

"Confirm with <OK>." 

Notes and warnings 
To highlight special information the following icons are used: 

 

 

Function call: 

"PRO.FILE" => "Extras" => "Options" => "Performance" 

 

 

Example: 

Boxes marked with this icon give subject-relevant examples for the usage of command 

lines, configuration strings and other software-relevant entries. 

 

 

Note: 

Boxes marked with this icon contain useful hints on the operation, configuration or 

installation of the PRO.FILE software. 

 

 

Attention: 

All information given in these boxes is very important and should be read carefully! 

Non-observance of these hints may lead to wrong functioning, display problems or 

other negative consequences. 

 

 

Important notes:  

The "stop sign" warns you of possible entry or operation errors, which may lead to loss 

of data! 

 

 

Attention – Undo not possible: 

All entries and configurations described in these boxes have to be made carefully, 

because they cannot be undone! 

 

Step-by-step 

instructions: 
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1 Welcome to the integration PRO.FILE – Microsoft 

Word Multi Document 

The Product Data and Document-Management System PRO.FILE classifies and 

manages documents and records from the technical and administrative sector. PRO.FILE 

works fully integrated in Microsoft Word. Documents can be stored directly from 

Microsoft Word in the PRO.FILE database. 

The functions for saving and searching are embedded in the menu "PRO.FILE", so that 

processing and creating on one hand and storing of documents on the other can take 

place without changing the user programs.  

During the saving process, the documents are classified with characteristics and 

metadate. These characteristics can be used later to find the document fast. Documents 

can be assembled in a folder or assigned to projects or products. It allows direct access 

to complete records needed within the scope of a business proceeding.  

All documents administrated in PRO.FILE are stored in a secure ''electronic vault''. The 

ability to access documents quickly allows the user to take the additional time for other 

productive activities. 

The PRO.FILE – Microsoft Word Multi-Document integration supports the storage and 

administration of master documents and sub-documents 

 

1.1 Please note: Important information 

In order to use the integration PRO.FILE – MS Word Multi Document successfully, the 

following configuration notes need to be observed: 

 

 

Note: Viewer for Office documents when using PRO.FILE variables 

For the correct display of Word documents with PRO.FILE variables, you should not 

use a separate viewer. A viewer does not automatically update the PRO.FILE variables 

upon opening, which may lead to the incorrect display of text information. In such 

cases, you should use Microsoft Word for viewing Word files. 

 

Detailed information on the configuration of the integration can be found in the manual 

"Installation and administration of the integration PRO.FILE Word Multi Document". 
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1.2 First steps with the PRO.FILE integration 

Via the read, save and information functions of the PRO.FILE integration, the user can 

access PRO.FILE directly from Microsoft Word and use the PRO.FILE functions and 

information. 

The first steps with the integration are explained in the following chapters: 

 Where can the functions of the PRO.FILE integration be found in Word? 

 How to log in to PRO.FILE? 

 An overview of the integration functions 

 

 

Note:  

The description of the integration functions assumes that the basic functions of 

PRO.FILE are known to the user. Additional information can be found in the manual 

"Operation PRO.FILE for Beginners". 

 

1.3 Where can the functions of the PRO.FILE integration be found in 

Word? 

In order to access the functions of the PRO.FILE integration directly from Word, the 

integration offers a menu "PRO.FILE" in the ribbon bar of MS Word. 

 

 

 

Via these buttons you can access all functions of the integration. A short overview is 

provided in the following chapter "An overview of the integration functions". 

 

1.4 An overview of the integration functions 

This chapter is to give you a short overview of the options and functions of the 

integration PRO.FILE – Microsoft Word. Detailed information on each of these functions 

can be found in later chapters of this manual. 
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These menu functions are used to save documents 

in PRO.FILE – as new document, as modified 

document or as a new version. (See chapter 

"Saving a document to PRO.FILE") 

 

 Save 
Changes that are made in a document or a linked object are transferred to 

PRO.FILE with this function. A prerequisite for this is that the document has been 

opened for editing and locked in PRO.FILE.  

If the document is not taken out you can use the function "Lock". You can also use 

the function "Save" to save new documents (without PRO.FILE relation) to PRO.FILE 

via the Checkin Wizard. 

 Select document from list  

The current document can be saved to an existing document description. If there is 

already a file saved to it, you will be asked if you want to overwrite the document or 

version it. 

 Version  
This function is used to create a new version of a document with the changes just 

made to the active document. If new OLE objects and/or graphics are linked to the 

document, these are also saved in PRO.FILE and linked to the new version. 

 Save NDF  
Saves the current document as NDF and stores it in PRO.FILE. 

 Managed Copy  
Via the function "Managed Copy" a document, including all objects/graphics and 

structures linked in PRO.FILE, can be duplicated. During this process the user can 

choose which of the existing linked elements is to be copied as well or is to be 

rereferenced. 

 

With this function a document saved in PRO.FILE can 

be opened in MS Word. (See chapter Opening 

documents from PRO.FILE). 

 

 

 Open  
The selected document is opened from PRO.FILE. If additional objects from 

PRO.FILE are linked to this document, the "Open" function behaves as configured 

in the PRO.FILE Management Console via the parameter "Version load options 

dialog". 

 As stored  

The selected document is loaded from PRO.FILE as it has been saved most recently. 

Save 

Open 
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 Open with latest versions  
The selected document will be taken from PRO.FILE with the newest version of the 

linked objects. 

 Open with released versions  
The selected document will be taken from PRO.FILE with the newest released 

version of the linked objects. 

 With version browser  
The selected document is opened from browser with the version constellation 

selected by you. 

 

With the function "New from template" a new document can be created 

based on an existing document in PRO.FILE. During this process, the new 

document is directly saved in PRO.FILE and then opened for editing in 

MS Word. See Chapter ""New from template" for the creation of 

documents" 

 

 

This area of the PRO.FILE ribbon 

allows access to the following 

functions:  

 Lock  

This function locks the current 

document in PRO.FILE. Also see 

the chapter "Lock: From viewing 

to editing"). 

 

 Unlock  
This function allows the unlocking of locked sub-documents (see chapter "Unlock"). 

 Discard changes  
Changes to the current document are discarded, the file is loaded again from 

PRO.FILE with its last saved status (see chapter "Discard changes) 

 Dissolve relation   
With this function the connection between the current document and PRO.FILE is 

removed. The Word document is then no longer connected to the PRO.FILE 

database. It can then be saved under a different document description in PRO.FILE 

(see chapter "Dissolve relation"). 

 

 Variables 

 Edit variables  
This menu entry offers the menu functions to add, remove or update PRO.FILE 

variables. 

(See chapter "Insert PRO.FILE information as document variable"). 

New 

Edit 
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 Refresh  

This function allows you to update inserted PRO.FILE variables within a 

document. 

 Insert  

Objects saved in PRO.FILE can be linked to or embedded in your document with 

these functions (see chapter "Quick inserting and linking of files and graphics from 

PRO.FILE"). 

 Link object  

Objects that are saved in PRO.FILE can be linked with the current document. 

The link between the document and the OLE Object Is created in PRO.FILE.  

 Embed object  
Objects that are saved in PRO.FILE can be embedded in the current 

document. No link must be created in PRO.FILE, as the OLE-Object is a part 

of the document. 

 Graphics  

Graphics saved in PRO.FILE can be linked to or embedded in your document with 

these functions (see chapter "Quick inserting and linking of files and graphics from 

PRO.FILE"). 

 Link graphic  

Graphic files that are saved in PRO.FILE can be linked with the current 

document. The link between the document and the graphic is created in 

PRO.FILE. 

 Embed graphic  

Graphic files that are saved in PRO.FILE can be embedded in the current 

document. No link has to be created in PRO.FILE, as the graphic is a part of 

the document 

 Insert FS-Link   
Using this function it is possible to define a selected section of text as a hyperlink. 

Once defined, the selected text is shown, as usual for hyperlinks, in blue and 

underlined. By double clicking on the link, the linked document can be opened. 

 

This menu section allows the administration of data sources for serial letters (see chapter 

"Insert the modification list from PRO.FILE 

Via the function "Modification list" => "Insert" the modification list from PRO.FILE can 

be inserted into the Word document. Depending on the PRO.FILE configuration various 

actions (e.g. the editing of a file in a specific status or the creation of a version/revision) 

cause the prompting for a modification list entry. Such entries can also be added, edited 

or deleted manually. 

 

In order to use the modification list in PRO.FILE, the fields of the modification list have 

to be configured in the Form Designer of the PRO.FILE Management Console. 

Furthermore, the positions of the table headings can be specified and formatted. For 

more details, see the manual "Installation and Administration Integration PRO.FILE MS 

Word Multi Document" or contact your administrator. 

 

Mail Merge 

Configuration 

required 
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1. Open the Word document from PRO.FILE. 

2. Select the function "Modification list" => "Insert". 

 The modification list is inserted in the Word document. 

 

To update the modification list in the document you can either: 

 open the Word file 

 select the function "Modification list" => "Refresh" 

 

  

Proceed as 

follows 
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1.5 Change the column headings 

When the modification list is inserted, the properties defined for the specified fields via 

the Form Designer in the PRO.FILE Management Console are applied to the table. You 

can edit these table headings. 

 

1. In Word, go to "File" => "Info" => "Properties" => "Advanced Properties". 

 

2. Go to the tab "Custom". 

 

3. From the "Properties" list, select the property name you want to change. 

4. Enter the new column heading into the field "Value". 

5. Apply your change with <Modify>. 

6. Close the dialog with <OK>. 

7. Go to the PRO.FILE integration menu and select the function "Modification list" => 

"Refresh". 

 The new column headings are displayed in the modification list table. 

Proceed as 

follows 
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1.6 Delete the modification list 

To delete the modification list from the Word document, please use the integration 

function, in order for all affected document properties to be properly removed from the 

document. 

Select the function "Modification list" => "Delete" from the integration menu. 

 The modification list is removed from the Word document. 

 The field properties of the modification list are removed from the document as well. 

 

 

Note: 

If the modification list is not removed via the integration function, this may lead to error 

messages due to remaining but defunct document properties. These properties then 

have to be removed manually. 

 

Creation and administration of serial letters"). 

 Insert data source  
This function adds a data source saved in PRO.FILE to the current document. 

 Remove data source  

Via this function, the data source assigned to the document is removed and the link 

in PRO.FILE is removed as well. 

 

The functions in this group are used for the working with 

master documents and subdocuments and their 

administration with PRO.FILE. 

 

 Refresh document  
Refreshes the document and all subdocuments referenced therein (see chapter 

"Refresh document"). 

 Insert  
Inserts a document from PRO.FILE as subdocument into the active document (see 

chapter "Insert subdocument"). 

The functions in this group are used to display 

information from PRO.FILE. 

 

 

Subdocuments 

View 



Operation Integration PRO.FILE - MS Word Multi-Document Creation and administration of serial letters 

PRO.FILE Release 8.7 
July 2017 Page 15 of 86 

 Document / Document form  
Displays the document description for the active document in PRO.FILE. 

 Document structure  
Displays the document structure of the active document. This list also includes 

documents without PRO.FILE relation. 

 

This group gives access to the following functions. See 

chapter "Extras, information and help" 

 

 

 Help  
This function is used to display the online help. 

 PROCAD on the web  
Opens the official web site of the company PROCAD. 

 Workcenter 
Opens the Workcenter window. There you find the local storage of documents 

opened from PRO.FILE. 

 About 
For information (e.g. version number) on the current configuration of the PRO.FILE 

integration. 

 Show info pane  
Shows the infor pane at the bottom of the screen. This pane contains infromation 

on document ID and mode. 

 

  

Extras 
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1.7 How to log in to PRO.FILE? 

When an integration function is selected for the first time within a Word session, 

PRO.FILE is started and, if PRO.FILE is not yet running in the background, a login is 

required. 

Via the login the user is identified by his/her PRO.FILE user name and password. The 

login also activates the configured function access rights and permissions for this 

logged-in user.  

 

In the login screen that is displayed 

please enter: 

 your PRO.FILE user name, 

 your PRO.FILE password. 

Confirm with <Login>. 

 The PRO.FILE GUI is displayed. 

 

 

 

Note: No login required if "Autologin" is activated 

The login is not required if the PRO.FILE autologin function is activated. 
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2 Opening documents from PRO.FILE 

PRO.FILE manages Offices documents centrally and makes them available from the 

secured storage location to the user. 

 If you want to open a document from PRO.FILE in Word, you can use the function 

"Open" of the integration. 

 This function "Open" starts the Checkout wizard, you can select the desired 

document and load it in Word. 

 

 

Note: PRO.FILE checks permissions 

When a document is opened from PRO.FILE, the access permissions of the user are 

checked: Is the user allowed to open the document?  

Is the user allowed to edit the document? 

These permissions depend on the function access rights of the user and the status-

dependent permissions. A document in a status "released" may probably no longer be 

edited. 

 

To open Word files from PRO.FILE, the integration PRO.FILE – Word offers the following 

ways of proceeding: 

 The "Open" function behaves as configured in the PRO.FILE Management Console 

via the parameter "Version load options dialog". 

 The function "Open as stored" loads the selected document from PRO.FILE as it 

has been saved most recently. 

 The functions "Open with newest versions" and "Open with released version" only 

relate to documents with linked OLE objects / graphics. In this case, it is possible to 

load the linked objects in specific version statuses from PRO.FILE to be displayed in 

the main document. (See chapter "Open with different version of linked objects") 

 "Open with version browser" allows the opening of the document via the version 

browsers. With this, documents can be opened with different version statuses of 

linked objects/graphics in dynamic compositions. 
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2.1 "Open" from PRO.FILE 

To open a Word document from PRO.FILE proceed as follows: 

 

 

Function call from the PRO.FILE menu in Word: 

Tab "PRO.FILE" => group "Open" => "Open" 

 

1. Select the function "Open" from the PRO.FILE menu of the 

integration in Word. 

 The checkout wizard for the selection of the desired 

document is displayed. 

 

The Checkout wizard displays the PRO.FILE GUI as it was recently opened. 

2. If the desired document is 

not yet displayed in a list 

or form, you can start a 

search for the document 

with the following 

functions: 

 Via the tab 

"Cockpit". 

 Via the search 

functions of the icon 

bar. 

 Via favorites, 

SmartSearch or task 

assignments. 

 

 

3. If the desired document is displayed in a list, select it (if the document is displayed 

in a form view, it is already selected). 

4. Click <Open>. 
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5. Depending on the configuration in 

the PRO.FILE Management Console, 

a dialog for the selection of version 

constellations may appear. See 

chapter "Open with different version 

of linked objects" 

 

 

6. You then have to decide in which mode the document is to be opened from 

PRO.FILE in Word. Three options are available: 

 

 For viewing:  

The document is opened 

write-protected and cannot 

be modified. 

 For editing:  

The document is locked for 

other users, can be modified 

by you and the changes can 

be saved back to PRO.FILE. 

 As a copy:  

A copy of the document 

without PRO.FILE connection 

is loaded. Changes to the 

document can only be saved 

to PRO.FILE under a new 

document description. 

 

 

7. Confirm with <Open>. 

 The selected document is now opened in Microsoft Word. 

 The opening process is thus finished. 

 

 

Attention: Can I save changes to PRO.FILE or not? 

It depends on the selected method for opening the document whether you can save 

changes to the document directly back to PRO.FILE or not. 

Detailed information on the loading method can be found in the chapter "Open for 

viewing, editing or as a copy – what are the consequences?". 
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Note: Why can I not open a document for editing 

You want to open a document for 

editing but the dialog does not offer 

the option "for editing"? 

This may have two reasons: 

 The document is locked by a 

different user. You can see in 

the status information of the 

document in PRO.FILE, which 

user has locked the document. 

 

  The document is in a status, in which you are not allowed to edit the document. 

 

In the next step you can now select which of the linked documents, e.g. subdocuments, 

are to be locked. 

8. Select the 

checkbox for all 

documents that 

are to be locked 

(see also chapter 

"Lock: From 

viewing to 

editing"). 

9. Confirm your 

selection with 

<OK>. 

 

 The document with all documents linked in PRO.FILE is opened. The documents 

selected in the "Lock" dialog are locked, i.e. reserved for your. This allows changes 

to the documents made by you to be saved back to PRO.FILE 

For detailed information on the opening of documents, please see the following 

chapters: 

 Quick selection: The PRO.FILE Checkout Wizard 

 Open with different version of linked objects 

 Open for viewing, editing or as a copy – what are the consequences? 
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2.2 Open with different version of linked objects 

 For files with linked objects and graphics, you can specify, which version of the linked 

objects and graphics is to be opened. The integration menu offers the following 

functions: 

 Open 

 Open "As stored" 

 Open "with latest versions" 

 Open "with released versions" 

 Open "with version browser" 

 

 

 

Note:  

These options do not refer to the document selected for opening from PRO.FILE. They 

only relate to the objects from PRO.FILE linked within the document. This is only the 

case if OLE objects or graphics have been linked into the document and then saved 

via the integration. Via the options of the "open" function, you indicate the version of 

the linked objects to be loaded from PRO.FILE. 

 

 This means: 

 "Open" 

The "Open" function behaves as configured in the PRO.FILE Management Console 

via the parameter "Version load options dialog". 

 Open "As stored"  
The selected document is loaded from PRO.FILE the way it was last saved. If 

additional objects from PRO.FILE are linked to the document, they are loaded in 

the version they were last used in the document. 

 Open with latest versions  
If additional objects from PRO.FILE are linked to the document, they are loaded in 

the newest available version. 

 Open with released versions  
If additional objects from PRO.FILE are linked to the document, they are loaded 

with the newest available version that is in a released status. 

 Open with version browser  
Via the version browser you can open documents with different version 

constellations of the linked objects/graphics. 

 



Operation Integration PRO.FILE - MS Word Multi-Document Open with different version of linked objects 

PRO.FILE Release 8.7 
July 2017 Page 22 of 86 

 

Note: Opening with version constellations is a matter of access rights! 

Each user has specific rights to see (or not to see) documents in different PRO.FILE 

statuses. This has effects on the opening with linked versions: 

 If a user may only see documents in the status "released", the option "with latest" 

version will only open the newest version in a released status, even if a newer 

version (in a non-released status) exists. 

 

2.2.1 Open with version browser 

Via the version browser you can open documents with different version constellations of 

the linked objects/graphics/subdocuments. 

During this 

process, you 

can specify 

via the version 

browsers, 

which version 

of the 

document 

and which 

versions of the 

linked objects 

are to be 

opened. 

 

The version browser is divided in two areas 

 The upper structure pane lists the main document with all linked objects/graphics. 

 Via the button <Expand all> you can show the entire structure of the main 

document. 

 The field "Loaded" shows the current opening method of the documents listed in the 

structure pane – without manual version choice. The opening method immediately 

affects the display of the structure pane:  

Via the <Change…> button you can choose among the four default opening 

methods: 

 Open "as stored" 

 Open "latest version" of the linked objects/graphics 

 Open "latest released version" of the linked objects/graphics 

 Open "latest released version or latest version" of the linked objects/graphics, 

depending on the availability. 

 

The document 

structure at the 

top 
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 The lower pane lists the different versions of a linked object/graphic. 

 Here you can select the version you want to open in your constellation. 

 

 

Function call from the PRO.FILE menu in Microsoft Word: 

Tab "PRO.FILE" => group "Open" => "With version browser" 

 

1. Select the tab "PRO.FILE" from the ribbon menu. 

2. In the group "Open" click on "More" => "With version browser" 

 The Checkout Wizard opens 

3. In the Checkout Wizard select the desired document and click on <Open>. 

Detailed information on the Checkout Wizard can be found in the chapter "Quick 

selection: The PRO.FILE Checkout Wizard". 

 The Checkout Wizard closes. 

 The window "Select document" is displayed. 

4. In the document structure select the component for which you want to select a 

different version. 

 The version pane at the bottom displays the available versions. 

5. By clicking the radio button in the first column you can select the desired version of 

the linked object/graphic:  

 

 

 

6. Once you have selected the desired version for all components, click on <Open> 

to open the document in the desired version constellation. 

The version pane 

at the bottom 

Proceed as 

follows: 
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7. You now have to decide, in 

which mode you want to 

open the document from 

PRO.FILE in Word. If you 

want to modify the 

document, you have to open 

it "for editing". 
Further information can be 

found in the following 

chapter "Open for viewing, 

editing or as a copy – what 

are the consequences?". 

 

8. Confirm with <OK>. 

 The document is opened with the selected versions of linked objects/graphics. The 

process of opening with the version browser is thus finished. 
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2.2.2 Open for viewing, editing or as a copy – what are the consequences? 

When openeing documents from PRO.FILE via the Checkin Wizard of the integration 

you have to decide, in which mode the document from PRO.FILE is to be opened in 

Word. Three options are available: 

 For viewing:  

The document  

 is not reserved (i.e. locked) for 

you in PRO.FILE. 

 and can thus be edited by other 

PRO.FILE users in the meantime. 

 is not saved back automatically 

to PRO.FILE after closing. 

 

To save changes to your document back to PRO.FILE, you have to use the function 

"Save" from the PRO.FILE menu. This is only possible if the document has been locked 

before. 

 For editing:  
The document  

 is locked for other users. 

 can be modified by you. 

 cannot be changed by other users in the meantime, but can be opened for 

viewing. 

 can be saved back to PRO.FILE upon closing with the changes made. 

 As copy:  

The document 

 is only treated as a copy of the "original" saved in PRO.FILE. 

 has no connection to PRO.FILE and is no longer monitored by PRO.FILE. 

 is therefore not locked in PRO.FILE. 

 is not saved back to PRO.FILE after closing. 

 can only be saved to PRO.FILE as a new document. 
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Attention: Only changes of "locked" documents can be saved back to PRO.FILE 

If a user wants to edit a document, this object has to be locked for other users at the 

beginning of the changes to be made in order to prevent concurring changes. This is 

the only way to prevent that several users are making changes to the same document 

at the same time. In order to change a document and be able to save the changes 

back to PRO.FILE you either have to 

 Open the document "for editing" right from the start. 

 Or lock the document after opening via the function "Reserve to change".  

For this, see chapter "Lock: From viewing to editing". 
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3 Saving a document to PRO.FILE 

To save files from MS Word in PRO.FILE the user 

can choose from the different functions: 

 "Save" 

This function can be used for two different 

requirements: 

 

 

 On the one hand, you can save new documents for the first time to PRO.FILE 

and create a document description. See chapter ""Save": Saving documents for 

the first time in PRO.FILE". 

 On the other hand, you can save changes you have made to a document, 

which has been opened from PRO.FILE, back to PRO.FILE. The saved status in 

PRO.FILE is then overwritten with the new status from Word. See chapter 

""Save": Saving a changed document back to PRO.FILE". 

 "Select document from list"  

This function is used to save a new document to an already existing document 

description. See chapter "Using the PRO.FILE function "Select document from list"". 

 "Create version"  

This function is used to create a new version of a document after changes have 

been made to it. Further information can be found in the chapter "Versions: Save as 

new version".  

 "Save NDF"  

Via this function a neutral format document (e.g. PDF) is created from the active 

document and saved to PRO.FILE with a document description that is linked to the 

"original" document. See chapter "Save NDF". 

 "Managed Copy"  
With Managed Copy you can duplicate documents including all objects and 

graphics linked from PRO.FILE. For all selected componets of the document a new 

document description is created in PRO.FILE. See chapter "Managed Copy". 

 Save upon closing  
If a document has been opened from PRO.FILE and edited in Word, the saving 

prompt upon closing the document is the final opportunity to save your changes. 

Further information can be found in chapter "Close Word: Save and remove lock?". 

 

 

Note:  

The description of the saving process to PRO.FILE relates to the function "Save" from 

the menu "PRO.FILE" in MS Word, not to the functions of the same name from the 

Menu "File". With the functions from the "File" menu in Word, the file is only saved 

locally in the file system and not in PRO.FILE. 
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3.1 "Save": Saving documents for the first time in PRO.FILE 

Saving files under a new document description is made with the function "Save" from the 

menu "PRO.FILE" '=> "Save" in Microsoft Word. 

There are two options: 

 "Save": The Word document is saved with a 

new document description in PRO.FILE if it 

does not already have a PRO.FILE relation. 

 

 "Select document from list": An existing document description is used to save a new 

Word document in PRO.FILE, i.e. the new document is attached to an existing 

document description. 

These steps are described in detail below. 

 

3.1.1 Using the PRO.FILE function "Save" 

To save a document for the first time to PRO.FILE, proceed as follows: 

 

 

Function call from the PRO.FILE menu in MS Word: 

"PRO.FILE" => "Save" 

 

Select the function "Save" from the tab "PRO.FILE" in the menu ribbon bar 

in Word. 

 

 

The saving of the file to PRO.FILE with the Checkin wizard is then made in two steps: 

 Step 1: Create a new document description 

 Step 2: Assigning the created data to a PRO.FILE project 

These steps are explained in the following sub-chapters. 

 

Note: Linked objects 

If other objects (graphics, OLE objects), which are not yet saved in PRO.FILE, are 

linked to the document to be saved, these objects are also offered for saving via the 

Checkin wizard. 
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If the option "Save" has been selected, a new document description is created during the 

saving process of the Word document in PRO.FILE. 

The document description is to classify and describe the document for further usage. 

 

The better a document 

is classified, the easier 

it will be for other 

users to find the 

document later in 

PRO.FILE. 

In the first step, a 

document description 

is therefore to be 

created. 

For this purpose, the 

Checkin wizard is 

displayed: 

 

 

Here, the Checkin wizard offers different options that can be accessed via the 

operations bar:  

 

Create new 

 A new document description is to be created for the new Word document to be 

saved. 

1. Select the desired document type. 

2. Fill in the form for the document description. 

3. Confirm your entries with <Next>. The document is saved in PRO.FILE. 

  

Step 1: Create a 

new document 

description 

Usage: 

Proceeding: 
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New using template 

 A new document description is to be created, but an existing document description 

is to be used as a template. 

 This way, the fields of the document form are already filled and only adjustments 

have to be made. 

 Example: Several document descriptions for letters of similar contents but to 

different recipients are to be created. In order not to fill in the same data over and 

over again, the function "New using template" is used and only the recipient fields 

need to be adjusted. 

 

1. Select the option "New using template" in the Checkin wizard. 

 The Checkin wizard displays the PRO.FILE GUI as it was recently used. 

2. If the document description to be used as a template is not yet displayed in a list or 

form view, you can use the search functions of the cockpit, the icon bar or favorites 

and SmartSearch to start a search.  

3. If the desired document is displayed in a list view after the search, you can now 

select it. (If the desired document is displayed in form view, it is already selected 

automatically).  

 Confirm the selection of the document description with <Next>.  

4. The input form for the creation of the document description is pre-filled with the 

data from the selected document description.  

5. Make the necessary adjustments to the pre-filled data.  

6. Once all required document data is entered, confirm the creation of the new 

document description in PRO.FILE with <Next>. The document is saved in 

PRO.FILE. 

 

 If you do not work with project assignment, the saving process is now finished.  

The newly saved document is opened in Word "for editing" and is locked for other 

users. You can continue editing the document. 

 If you are working with project assignment, this project assignment is to be made in 

the next window of the Checkin wizard. 

 In this case continue with chapter "Step 2: Assigning the created data to a PRO.FILE 

project". 

 

  

Usage: 

Proceeding: 
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In this step, the saved Word document can be assigned to a specific project in 

PRO.FILE.  

 

 

Note: Usage of PRO.FILE projects 

This second step of the Checkin wizard is intended for the usage of PRO.FILE projects. 

If you do not use PRO.FILE projects: 

 you can skip this step with the <Skip> button. 

 the second window of the Checkin wizard is perhaps not even displayed, since the 

administrator may have disabled it. 

 

For this project assignment of the new document description an existing project must be 

selected in PRO.FILE, or a new project must be created, and then activated. 

Note: If several documents or linked objects are being saved. The title bar of the 

Checkin wizard displays the name of the object currently handled. 

Here, too, the Checkin wizard offers different options that can be accessed via the 

operations bar: 

 

 

 

Attention: Project must be activated  

In order for a Word document to be linked to a project, this project must be 

ACTIVATED. This means that for all of the options, you have to select the option 

"Activate" afterwards.  

 

Step 2: Assigning 

the created data 

to a PRO.FILE 

project 
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The proceeding for these options is the same as for the first step of the Checkin wizard: 

 Create new:  
A new project is created in PRO.FILE. The document 

description created in step 1 is assigned to this new 

project. 

 

 Search:  
The document description created in step 1 is to be 

assigned to an existing project. This project is now 

searched via the search form and selected.  

 

 Select in list:  

The document description created in step 1 is to be 

assigned to an existing project. This project is already 

displayed in a PRO.FILE list and only has to be 

selected and confirmed. 

 

 Activate:  

If a project is activated, all documents in PRO.FILE are 

automatically assigned to this project. If no project is 

currently activated, and you want to do so, you can 

use this function to activate a project. 

 

 Deactivate  
Again: If a project is activated, all new documents in 

PRO.FILE are automatically assigned to this project. If 

this assignment is not to be made for the current 

document, you can deactivate the project before 

finalizing the saving process.  

Note: If a project is activated, this is displayed in the 

title bar of the active PRO.FILE window. 

 

 

For the assignment of new documents to a project via the Checkin wizard proceed as 

follows: 

1. Select an existing project or create a new one via the options displayed. 

2. Select this project in the list view (projects in form view are automatically selected). 

You now must select "Activate". Only if the selected project has been activated, the 

assignment to the project is made after confirmation. 

3. Confirm your proceeding with <Finish>. 

 

 The saving of the Word document in PRO.FILE is now finished. The newly saved 

document is opened in Word "for editing" and is locked for other users. You can 

continue editing the document. 

 

  

Proceeding: 
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3.1.2 Using the PRO.FILE function "Select document from list" 

With the function "Select document from list" a new Word document can be saved 

along with an existing document description. 

The existing document description is assigned the new document from MS Word: 

 If another file is already attached to this document description, you can choose 

whether you want to overwrite or create a version of the existing document. 

 

 

Note: Is a file attached to a document description? 

Whether or not a file is already attached to a document description can be seen from 

the icon  in the first column of the document list. 

 

To select the document 

description you want to assign 

the Word document to, you 

can use the Checkin wizard. 

The aim is to select the 

document description the new 

Word document is to be 

attached to. 

 

 

1. Select the function "Save" => "Select document 

from list" from the tab "PRO.FILE" in the menu 

ribbon bar in Word. 

 

2. The Checkin wizard displays the PRO.FILE surface, as it was opened the last time 

you used it.  

If the desired document description is not yet displayed in a list or form view, you 

can use the search functions of the home page, the icon bar or favorites and 

SmartSearch to start a search.  

3. If the desired document is displayed in a list view after the search, you can now 

select it. (If the desired document is displayed in form view, it is already selected 

automatically).  

4. Confirm the selection of the document description with <Open>. 

 

Proceed as 

follows: 
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 If no document is yet attached to the document description, the new Word 

document is now directly attached to this document description. The Word 

document is thus saved in PRO.FILE.  

The newly saved document is opened in Word "for editing" and is locked for other 

users. You can continue editing the document. 

 

5. If a document is already attached 

to the selected document 

description, you now have to 

decide: 

 whether you want to overwrite the 

attached document with the new 

document from Word, 

 or whether you want to create a 

new version of the attached 

document. In this case, the attached 

document remains available as old 

version of the new document from 

Word. 

 

6. Confirm your selection with <OK>. The new Word document is now saved in 

PRO.FILE. 

 

 

Warning: Undo not possible! 

The overwriting of a file with the above method cannot be undone. The overwritten file 

is irretrievably lost! 

 

 

Note:  

For each document description only one file can be saved, since the document 

description is to exactly describe this document.  

 

 If you do not work with project assignment, the saving process is now finished. 

 If you are working with project assignment, this project assignment is to be made in 

the next window of the Checkin wizard. 

 In this case continue with chapter "Step 2: Assigning the created data to a 

PRO.FILE project". 
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3.2 "Save": Saving a changed document back to PRO.FILE 

Via the function "Save" of the "PRO.FILE" integration menu in Word, documents that 

have been opened from PRO.FILE "for editing" can be saved back to PRO.FILE. 

 With this function, changes made to the Word document are saved to PRO.FILE. 

 The current state of the document in PRO.FILE is overwritten with the modified state 

from Word. 

 The document remains open for editing in Word after saving. 

 

 

Attention: "Save" works only for documents locked "for editing" 

The functions only saves changes to document that have been opened "for editing" or 

that have been "locked" later on. 

 PRO.FILE prevents concurrent changes of different users to the same document. 

For this, a document is locked for all other users once it is opened "for editing" by 

you. 

 This is the only way to make sure that only the most up to data state of a 

document can be modified and saved back. 

A document that has been opened "for viewing" can later be "reserved to change", as 

described in chapter "Lock: From viewing to editing". 

 

 

Function call from the PRO.FILE menu in MS Word: 

"Tab "PRO.FILE" => group "Save" => "Save" 

 

1. Select the function "Save" => "Save" from the "PRO.FILE" menu in Word. 

 PRO.FILE recognizes that this document already exists in PRO.FILE and has a 

document description. 

 The changes to your document are saved to PRO.FILE. The current state of the 

document in PRO.FILE is overwritten with the modified state from Word. 

2. Depending on the 

configuration and 

PRO.FILE status, you now 

have to enter a 

modification comment.  

 

Enter the comment 

information into the fields 

on the dialog screen.  

 

 

3. Confirm your modification comment with <OK>  

Proceed as 

follows: 
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4. The modification comment screen is closed; your modification comment can now 

be found in the "Modification list" in PRO.FILE. 

 The saving of your changes to PRO.FILE is now finished. You can continue editing 

the Word document or close it. 

 

 

Note: Automatic versions 

If for the document type of the document to be saved the parameter "Automatic 

version" is activated in the PRO.FILE Management Console, a new version will be 

created each time the document is saved. This happens in the background without a 

dialog being displayed. 

 

The document remains open in Word after saving – you do not need to open it again 

from PRO.FILE. 

If you do not want to continue editing the document, you can close Word after saving to 

PRO.FILE. 

See also the following chapter "Close Word: Save and remove lock?". 

 

3.3 Versions: Save as new version 

With the PRO.FILE – Word integration it is possible to save different versions of the same 

document to PRO.FILE. 

 

Note: 

A new version can always be created from the most recent version (provided that status 

and user permissions allows this). Whether the creation of versions from older versions 

is allowed, depends on the parameter configuration in the PRO.FILE Management 

Console. If necessary, contact your system administrator. 

 

When the function "Create version" is used, the document in Word is saved as a new 

version of the original document in PRO.FILE. 

 Only the document active in Word is versioned. 

 The old version of the document remains also in PRO.FILE. 

 The new version is saved under a new document ID in PRO.FILE and directly 

displayed in Word. The version/revision counter for this document is increased in 

the document description in PRO.FILE. 

 The new version is opened in Word "for editing", i.e. you can continue working with 

this new version and save any changes back to PRO.FILE. 
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Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Save" => "Create Version" 

 

1. Select the function "Save" => "Create Version" from the "PRO.FILE" menu in Word. 

2. If did not open the newest version from the version list, but an older version instead, 

an information dialog is displayed first. 

3. Confirm with <Yes>. 

 An overview is displayed of 

documents, for which a new 

version is to be created. 

 

4. Confirm this list with <OK> 

 A new version is created of the current document in PRO.FILE.  

The new version is directly displayed in Excel, and you can continue editing the 

document. 

 If OLE objects and/or graphics had been linked to the document, they are also 

saved in PRO.FILE and linked to the new document version. 

  

 

Attention: After the versioning, the new version is displayed 

After a document has been saved as a new version, the new version is displayed in 

Word. This new version is opened "for editing" and reserved for you. The "old" version 

is closed and remains in PRO.FILE. 

 

3.4 Save NDF 

The PRO.FILE integration offers the user the option to convert Office files into neutral 

data formats (e.g. PDF) and save them as documents in PRO.FILE. By calling the 

function "Save NDF", a neutral format file is created from the current document and 

saved to PRO.FILE. 

This NDF document is then in PRO.FILE automatically attached to the document 

description of the original document. 

 

 

Note: Save NDF via "Format generators" 

The function "Save NDF" is configured via the configuration of the format generators. 

This requires corresponding installations and settings. Please contact your system 

administrator. 

Proceed as 

follows: 
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Function call from the PRO.FILE menu in MS Word 

Tab "PRO.FILE" => group "Save" => "More" => "Save NDF"  

 

For the creation of the neutral format document proceed as follows: 

1. You have opened a document and want to save this processing state in a neutral 

data format in PRO.FILE 

2. Select the tab "PRO.FILE". 

3. Click on "More" => "Save NDF" in the group "Save". 

 A query, whether you want to create a neutral format, is displayed. 

4. Confirm with <Yes>. 

 The neutral format is now created 

 Depending on the configuration, no further interaction is required. 

 The created NDF document is saved automatically to PRO.FILE and linked to the 

document description of the original Word document. 

 The creation of the neutral format document is thus finished. 

 

3.5 Managed Copy 

When duplicating documents structured with elements from PRO.FILE, Managed Copy 

allows the user to select specifically, which of the linked elements are also to be 

duplicated and which are only to be referenced. 

 For each element linked in the document, you can decide whether this element is 

also to be copied and the duplicate to be saved in PRO.FILE. 

 For all linked elements that are not duplicated, the existing references remain 

intact. 

Managed Copy thus allows the targeted saving of documents with linked elements as 

new copy, as well as the changing of names of the linked elements. The user can decide 

which elements to save. 

 

 

Function call from the PRO.FILE menu in MS Word 

Tab "PRO.FILE" => group "Save" => "More" => "Managed Copy"  

 

If the function "Managed Copy" is called, all linked elements are displayed in a tree 

structure. The top node and the first level are expanded. 
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The checkmark "Selection" is now to beset for all objects that are to be included in the 

"Managed Copy" process. 

 In the column "Selection" select all elements to be copied. 

 You can edit the file name directly in the list. 

 The column "Status" shows an exclamation mark if an error has occurred. By 

hovering over the icon with the mouse, a tooltip is displayed. 

If you click <OK>, the database relation is cut for all selected objects and the resulting 

local copies are saved anew in PRO.FILE. For all objects that have not been selected, 

only the reference is copied. 

To finalize the "Managed Copy" process, you now have to create new document 

descriptions in PRO.FILE for all objects selected in step 1. 

 The PRO.FILE 

Checkin Wizard is 

displayed for the 

creation of new 

document 

descriptions. 

 The document 

information is 

requested for each 

selected 

object/graphic. 

 

Information on the handling of the Checkin Wizard can be found in the previous 

chapter ""Save": Saving documents for the first time in PRO.FILE". 

Once all copied documents are saved in PRO.FILE the "Managed Copy" process is 

finished. 

 

What happens 

next? 
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4 "New from template" for the creation of documents 

The PRO.FILE – Word integration offers the function "New from template". This function 

is used to create a new document based on another document already saved in 

PRO.FILE. 

An example: 

 You want to create a new document. 

 There is already a document in PRO.FILE of similar contents, which is to serve as a 

template. 

 If you use the function "New from template" from the PRO.FILE menu in Word to 

select the document to be used as a template, a new document is created with the 

contents of the template and saved as a new document in PRO.FILE. 

 

To create a new Word document based on a template document saved in PRO.FILE 

proceed as follows: 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "New" => "New from template" 

 

1. Select the function "New from template" from the "PRO.FILE" menu in 

Word. 

 The Checkout wizard is displayed to select the desired document 

template.  

 

You now have to select the document that is to be used as a template for the new 

document you want to create in Word. 

The Checkout wizard displays the PRO.FILE surface, as it was opened the last time you 

used it. 

The proceeding: 
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2. If the desired document 

description is not yet 

displayed in a list or form 

view, you can use the 

search functions of the 

Cockpit page, the icon 

bar or favorites and 

SmartSearch to start a 

search. 

 

 

3. If the desired document is displayed in a list view after the search, you can now 

select it. (If the desired document is displayed in form view, it is already selected 

automatically). 

4. Confirm the selection of the document description with <Open>. 

 

Detailed information on the Checkout wizard can be found in the chapter "Quick 

selection: The PRO.FILE Checkout Wizard". 

You now have to create the document description for the new document in PRO.FILE. 

For this purpose, the 

Checkin wizard is 

displayed. 

You now can enter the 

classification 

information for your 

new document, i.e. 

the document 

description. 

 

The Checkin wizard offers different functions that can be accessed via the operations 

bar in the window. 

5. Select 

 Either "Create new", to create an entirely new document description for the new 

Word document. 

 Or "New using template", if a new document description is to be created but the 

data of an existing document description is to be used as template. 
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6. Enter the document description data into the provided fields. 

7. Confirm your entries with <Finish>. 

 The new document description is saved in PRO.FILE in the start status of the 

document type or the user (depending on the configuration). 

Detailed information on the Checkin wizard can be found in the chapter "Step 1: Create 

a new document description". 

The document created via the "New from template" function is now displayed in Word. 

The document is opened "for editing" (as shown in the info pane of the integration. 

 

The document is locked for other users. You can make the desired changes to the 

document. 

8. Once you have finished editing the document, you can save your changes back to 

PRO.FILE as described in the chapter ""Save": Saving a changed document back to 

PRO.FILE". 

9. The document is then closed in Word and can be unlocked in PRO.FILE. See 

chapter "Close Word: Save and remove lock?". 

 The action "New from template" is thus finished. 

 

 

Note: Clear advantage of "New from template" with PRO.FILE variables 

If PRO.FILE variables are used in Word, their fields are automatically filled and 

updated when the new document is created via the function "New from template"!  

The variables information is directly loaded from the document description – manual 

adjustments are not necessary. 

Information on the creation of document templates with PRO.FILE variables can be 

found in the chapter "Tips and tricks: Creating a document template with PRO.FILE 

variables" 
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5 Edit: Functions regarding the PRO.FILE relation 

The menu group "Edit" of the PRO.FILE menu contains different functions relating to the 

status and the "relation" between the Word document from PRO.FILE and PRO.FILE 

itself. 

 "Lock" 

 "Unlock" 

 "Discard changes" 

 "Dissolve relation" 

Detailed information on these 

functions can be found in the 

following sub-chapters. 

 

 

The other functions of the "Edit" group are described in the chapters: 

 Quick inserting and linking of files and graphics from PRO.FILE 

 Insert PRO.FILE information as document variables 

 

5.1 Lock: From viewing to editing 

You have opened a document from PRO.FILE for viewing, i.e. the document is not 

locked. Now you want to change it. In this case, you must "lock" the document. 

 With the function "Lock" a document opened from PRO.FILE for viewing can be 

edited and subsequently be saved back to PRO.FILE. 

 Whether the document in Word is opened "for viewing" can be seen in the info 

pane of the integration:  
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Attention: Only documents that have been locked can be saved 

If a user wants to edit a document, this object has to be locked for other users at the 

beginning of the changes to be made in order to prevent concurring changes. This is 

the only way to prevent that several users are making changes to the same document 

at the same time. 

In order to change a document and be able to save the changes back to PRO.FILE you 

either have to 

Open the document "for editing" right from the start. 

Or lock the document after opening via the function "Lock". 

 

 

Function call from the PRO.FILE menu in  MS Word: 

Tab "PRO.FILE" => group "Edit" => "Lock" 

 

1. Select the function "Edit" => "Lock" from the PRO.FILE menu in Word. 

2. In the displayed lock dialog, 

select the 

objects/subdocuments that 

are to be locked by 

selecting the corresponding 

checkbox. 

(Documents that are already 

locked cannot be selected. 

3. Confirm your selection with 

<OK>. 

 

 

 PRO.FILE checks your permission to change the document. PRO.FILE also checks 

whether the document is already opened and locked by a different user. 

 If this check returns a positive result, i.e. the document is available for editing, it is 

opened "for editing" and locked for other users. The info pane will display this 

accordingly:  

 

 

You can now make the desired changes to the document. To save your changes back to 

PRO.FILE, please see chapter ""Save": Saving a changed document back to PRO.FILE". 

  

Proceed as 

follows:  
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5.2 Unlock 

You have opened a document from PRO.FILE for editing and you have locked the 

document and the affected subdocuments. You now want to remove this lock, so that 

other users can also edit a document. 

 With the function "Unlock" you can select documents and subdocuments that are 

locked in PRO.FILE in order to unlock them, so that they can be edited by other 

users. 

 

 

Attention: Only changes to documents that have been locked can be saved 

If a user wants to edit a document, this object has to be locked for other users at the 

beginning of the changes to be made in order to prevent concurring changes. This is 

the only way to prevent that several users are making changes to the same document 

at the same time. 

Before unlocking documents, you must change any changes made to your documents. 

See also chapter "Saving a document to PRO.FILE". 

 

 

Function call from the PRO.FILE menu in  MS Word: 

Tab "PRO.FILE" => group "Edit" => "Unlock" 

 

1. Save the documents or subdocuments, for which the made changes are to be 

transferred to PRO.FILE, via the function "PRO.FILE" => "Save". 

2. Select the function "Edit" => "Unlock" from the PRO.FILE menu in Word. 

3. In the displayed unlock 

dialog, select the 

objects/subdocuments that 

are to be unlocked by 

selecting the corresponding 

checkbox. 

(Documents that are not 

locked cannot be selected. 

4. Confirm your selection with 

<OK>. 

 

 The selected documents / subdocuments are unlocked in PRO.FILE. 

 If the superior document / master document is unlocked, the info pane will show 

that this document is now only opened for viewing: 

Proceed as 

follows:  
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You can now make the desired changes to the document. To save your changes back to 

PRO.FILE, please see chapter ""Save": Saving a changed document back to PRO.FILE". 

 

5.3 "Discard changes" 

 

 

Attention: Undo not possible – risk of data loss! 

The function "Discard changes" discards all changes to the document that have not yet 

been saved back to PRO.FILE. This action cannot be undone. All discarded changes 

are permanently lost! 

 

With the function "Discard changes" you can reset the modification state of the 

document to the state last saved in PRO.FILE. All changes made since this last saving 

process are thus deleted. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Discard changes" 

 

1. Select the function "Edit" => "Discard changes" from the "PRO.FILE" menu in 

Word. 

 A dialog is displayed asking 

you whether you really want 

to discard all changes and 

load the document anew. 

2. If this is what you want to do 

confirm the dialog with 

<Yes>. 

 

 

 The document is now opened again with the last saved state from PRO.FILE. The 

document is opened "for editing" and locked for other users. 

 You can now continue editing the document. 

 

Proceed as 

follows: 
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5.4 "Dissolve relation" 

This function dissolves the connection between the active document and the 

corresponding PRO.FILE document description. The document thus no longer has a 

PRO.FILE connection and is treated as a local file. 

 The document can now be changed and saved as a new document in PRO.FILE 

with a different name and document ID. 

 The "old" document still exists in PRO.FILE. The function "Dissolve relation" does not 

delete a document or document description. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Dissolve relation" 

 

1. Select the function "Edit" => "Dissolve relation" from the "PRO.FILE" menu in 

Word. 

2. In the wizard that is 

now displayed, 

select the 

components of the 

document to be 

dissolved as well. 

 The document no 

longer is a 

PRO.FILE 

document. 

Subsequent 

changes are not 

saved back to 

PRO.FILE. The title 

bar of Word 

displays that the 

document no 

longer is 

connected to 

PRO.FILE. 

 

3. Confirm your selection with <OK>. 

 The document now no longer is a PRO.FILE document. Further changes are not 

saved back to PRO.FILE. The info pane of the integration displays this accordingly. 

 

Proceed as 

follows: 
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6 Quick inserting and linking of files and graphics from 

PRO.FILE 

With PRO.FILE it is possible to combine documents from different sources in one 

document, a so-called compound document. A compound document consists of one 

main document and several other documents embedded in or linked to the main 

document. 

These files and documents are called OLE objects (Object Linking and Embedding). 

OLE is a technology developed by Microsoft to actively import data from another 

program. If, for example, a Word table is linked to a Word document and the Word 

table is changed afterwards in Word, the displayed table in Word changes as well. 

OLE objects can be all sorts of files from the same or a different application. 

When inserting an object, i.e. a graphic, a file or part of a file into the main document, 

you can use a linked or embedded object. 

 

The functions for linking and embedding differ in the location, where the data of the 

inserted object is saved, and the way the object is updated after insertion into the main 

document: 

 Linked object  

Linked objects are not part of the main document, but the main document only 

contains a path and file name reference to which file is to be displayed at this 

position in the document. For a linked object, the contained information can only 

be modified and refreshed in the display in the main document, if the source file is 

edited. Linked objects are stored in the source file. The main document as target 

file only saves a reference to this source file and displays it. If the source file is 

edited, the main file will display the updated state of the source file when the main 

document is opened or refreshed. 

 Embedded object  

By embedding an object into the main document, the object becomes part of the 

main document. The displayed data is saved within the main document. When the 

source file is modified, the displayed information in the main document is not 

updated. 

 

The PRO.FILE – Word integration allows the linking and embedding of objects that are 

saved in PRO.FILE or that can be saved in PRO.FILE. 

Further information can be found in the following sub-chapters. 

 

  

Embed or link: 

What is the 

difference? 
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6.1 Linking or embedding graphics and OLE objects 

The integration differentiates between the linking and embedding of 

 Graphics from PRO.FILE and 

 OLE objects from PRO.FILE. 

 

There are therefore 4 functions available, which can be accessed via the integration 

menu in Word: 

 Embed object 

 Link object 

 Embed graphic 

 Link graphic 

Furthermore, you can insert a hyperlink to a document in 

PRO.FILE into your Word document: 

 Insert FS-Link 

For detailed information, see the following sub-chapters. 

 

 

 

Note:  

To link/embed objects saved in PRO.FILE you must use the function "Link object/Link 

graphic" from the integration menu. If you use the Word function for the linking of 

OLE objects, a new document description is created for each link when the main 

document is saved to PRO.FILE. 

 

For the selection of the objects to be linked/embedded, the user is supported by the 

Checkout wizard. 

Information on the Checkout wizard can be found in the chapter "Quick selection: The 

PRO.FILE Checkout Wizard". 
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6.2 Embed object 

The embedding of objects is used to include a source file into the main document. The 

embedded object becomes part of the main file and PRO.FILE treats the main document 

with embedded objects like one document. 

Changes to the source file of the object do not affect the main document and the 

objects embedded therein. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Insert" => "Embed object" 

 

To embed an OLE object already saved in PRO.FILE proceed as follows: 

1. Place the cursor at the position in the document, where you want to insert the OLE 

object. 

2. Select the function "Insert" => "Embed object" from the "PRO.FILE" menu in Word. 

 The Checkout wizard is displayed. 

3. Select the document description of the desired object to be embedded.  

(Information on the Checkout wizard can be found in the chapter "Quick selection: 

The PRO.FILE Checkout Wizard".) 

4. Click <Open>. 

 The selected file is now embedded into your Word document. It has become part of 

the Word document. Changes to the source file of the embedded object do not 

affect your Word document. 

 

In order to edit the embedded object, double-click on it. Word will automatically open 

the program the embedded object had been created with (source program). 

You can now make changes to the embedded object. These changes only affect the 

object embedded in your Word document, not the source file of the object. 

 

  

Step by step: 

Changes to an 

embedded OLE 

object 



Operation Integration PRO.FILE - MS Word Multi-Document Link object 

PRO.FILE Release 8.7 
July 2017 Page 51 of 86 

6.3 Link object 

The linking of OLE objects via the integration is used to link files from PRO.FILE into a 

main document in Word. 

Linked objects are not part of the main document. Instead, the main document contains 

a path and file name link to the file to be displayed at this position. For a linked object, 

the contained information can only be modified and refreshed in the display in the main 

document, if the source file is edited.  

Linked objects are stored in the source file. If the source file is edited, the main file will 

display the updated state of the source file when the main document is opened or 

refreshed. 

PRO.FILE administrates the main document and the linked objects as separate 

documents or files and supervises the link structures resulting from the usage of the link 

function in the integration. If the main document is opened from PRO.FILE, the linked 

files are loaded from PRO.FILE and displayed in the main document. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Insert" => "Link object"" 

To link an OLE object that is already saved in PRO.FILE into a Word document proceed 

as follows: 

1. Place the cursor at the position in the document, where you want to insert the OLE 

object. 

2. Select the function "Insert" => "Link object" from the "PRO.FILE" menu in Word. 

 The Checkout wizard is displayed. 

3. Select the document description of the desired object to be linked.  

(Information on the Checkout wizard can be found in the chapter "Quick selection: 

The PRO.FILE Checkout Wizard".) 

4. Click <Open>. 

 The selected file is now linked at the selected position in your Word document. The 

file is not part of your main document; the main document only saves the link to the 

source file. Changes to the source file are displayed in the main document when 

the main document is opened again from PRO.FILE or refreshed. PRO.FILE only 

memorizes and supervises the link in the document structure. 

 

For a linked object, the contained information can only be modified and refreshed in 

the display in the main document, if the source file is edited in PRO.FILE. 

 

The linking of files in PRO.FILE via the Word integration creates a document structure. 

  

Step by step: 

Changes to linked 

OLE objects 

Display of the 

resulting structures 
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To view this structure or to check the links used in a document, the following functions 

are available: 

 In the menu of the PRO.FILE – Word integration, the function "Document" => 

"Document structure". 

 At the PRO.FILE surface, the PRO.FILE function "View" => "Browser" 

 At the PRO.FILE surface the dependent tabs "Browser" (view of the main document) 

and "Where used" (view of the linked document). 

 

6.4 Embed graphic 

The embedding of graphics via the integration is used to include graphic files from 

PRO.FILE into a main document in Word as fixed parts of the main document. Changes 

to the original document have no effect on the main document and the graphic 

embedded therein. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Insert" => "Embed graphic" 

 

To embed a graphic file that is already saved in PRO.FILE into a Word document 

proceed as follows: 

1. Place the cursor at the position in the document, where you want to insert the 

graphic file. 

2. Select the function "Graphics" => "Embed graphic" from the "PRO.FILE" menu in 

Word. 

 The Checkout wizard is displayed. 

3. Select the document description of the desired graphic file to be embedded.  

(Information on the Checkout wizard can be found in the chapter "Quick selection: 

The PRO.FILE Checkout Wizard".) 

4. Click <Open>. 

 The selected graphic file is now embedded into your Word document. It has 

become part of the Word document. Changes to the source file of the graphic do 

not affect your Word document. 

 

In order to edit the graphic, double-click on it. Word will automatically open the 

program the graphic had been created with (source program). 

 You can now make changes to the embedded graphic. These changes only affect 

the graphic embedded in your Word document, not the source file of the graphic. 

  

Step by step: 

Changes to an 

embedded 

graphics 
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6.5 Link graphic 

The linking of graphics via the integration is used to link graphic files from PRO.FILE into 

a main document in Word. 

Linked graphics are not part of the main document. Instead, the main document 

contains a path and file name link to the file to be displayed at this position. For a 

linked graphic, the contained information can only be modified and refreshed in the 

display in the main document, if the source file is edited.  

Linked graphics are stored in the source file. If the source file is edited, the main file will 

display the updated state of the source file when the main document is opened or 

refreshed. 

PRO.FILE administrates the main document and the linked graphics as separate 

documents or files and supervises the link structures resulting from the usage of the link 

function in the integration. If the main document is opened from PRO.FILE, the linked 

files are loaded from PRO.FILE and displayed in the main document. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Insert" => "Link graphic" 

 

To link graphic file that is already saved in PRO.FILE into a Word document proceed as 

follows: 

1. Place the cursor at the position in the document, where you want to insert the 

graphic. 

2. Select the function "Graphics" => "Link graphic" from the "PRO.FILE" menu in 

Word. 

 The Checkout wizard is displayed. 

3. Select the document description of the desired graphic to be linked.  

(Information on the Checkout wizard can be found in the chapter "Quick selection: 

The PRO.FILE Checkout Wizard".) 

4. Click <Open>. 

 The selected file is now linked at the selected position in your Word document. The 

file is not part of your main document; the main document only saves the link to the 

source file. Changes to the source file are displayed in the main document when 

the main document is opened again from PRO.FILE or refreshed. PRO.FILE only 

memorizes and supervises the link in the document structure. 

 

For a linked object, the contained information can only be modified and refreshed in 

the display in the main document, if the source file is edited in PRO.FILE. 

  

Step by step: 

Changes to linked 

graphic 
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The linking of files in PRO.FILE via the Word integration creates a document structure. 

To view this structure or to check the links used in a document, the following functions 

are available> 

 In the menu of the PRO.FILE – Word integration, the function "Info" => "Document 
structure". 

 At the PRO.FILE surface, the PRO.FILE function "View" => "Browser." 

 At the PRO.FILE surface the dependent tabs "Browser" (view of the main document) 

and "Where used" (view of the linked document). 

 

6.6 Insert FS-Link 

With the function "Insert FS-Link" from the menu "PRO.FILE" or the toolbar, it is possible 

to create a link to another document within PRO.FILE from a highlighted Word or 

section of text.  

If a user later opens the document and clicks on the created hyperlink, PRO.FILE opens 

and the linked data record is displayed. 

 

Function call from the PRO.FILE menu in MS Word: 

"Tab "PRO.FILE" => group "Edit" => "Insert" => "Insert FS-Link" 

 

To insert a hyperlink to a PRO.FILE document into your Word document proceed as 

follows: 

1. Select the string of characters in your Word document you want to make a 

hyperlink. 

2. Select the function "PRO.FILE" => "Insert FS-Link" from the integration menu. 

 The Checkout wizard is displayed. 

 Select the document description of the document to be linked.  

(Information on the Checkout wizard can be found in the chapter "Quick selection: 

The PRO.FILE Checkout Wizard".) 

3. Click <Open>. 

 The desired hyperlink is created in your Word document. By default, it is displayed 

in blue and underlined (default format template). 

 

Display of the 

resulting structures 
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7 Insert PRO.FILE information as document variables 

When working with Word, you can insert different fields serving as placeholders for 

variable data. A common example is the "Page" field displaying the page number in the 

document. 

The integration PRO.FILE – Word enhances this functionality by the option to display 

data from the document description in PRO.FILE in your Word document. 

Information saved in the document description in PRO.FILE, e.g. the document ID, 

document type, creation date, etc., can thus be displayed in the corresponding Word 

document. 

Data displayed via this function from PRO.FILE are called "PRO.FILE variables". 

 

For each document saved in PRO.FILE, a document description is created. This 

description contains information: 

 on the document type, name of the document, document ID, language, usage, etc. 

 on the status of the document, the creation date, the creator, modification date, 

version, workflow status, etc. 

If you want to include this information in your Word document, it is not a good idea to 

enter this information manually, since this would be duplicate information, which would 

require manual adjustments when the information in the document description changes. 

With the PRO.FILE variables this update adjustment is made automatically. 

 Information from PRO.FILE is inserted as fields – with or without title – into the 

document. 

 Changes in the document description are automatically updated when the Word 

document is opened again from PRO.FILE or refreshed. 

An example would be the following image of a document footer: 

 

All information in this image has been inserted as PRO.FILE variables. Changes to the 

saved status or to the classification of the document in PRO.FILE are thus automatically 

updated in the Word document as well. 

The functionality of PRO.FILE variables is specifically useful for the saving of document 

templates in PRO.FILE. If a new document, based on such a template, is saved in 

PRO.FILE and the corresponding document description is created, the information is 

updated in the new document. 

  

The advantage of 

PRO.FILE 

variables: 
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Information on the usage of PRO.FILE variables can be found in the following sub-

chapters: 

 How to insert PRO.FILE variables into a Word document? 

 How to update PRO.FILE variables in a document? 

 How to delete PRO.FILE variables from a document? 

 

 

Note: Viewer for Office documents when using PRO.FILE variables 

For the correct display of Word documents with PRO.FILE variables, you should not 

use a separate viewer. A viewer does not automatically update the PRO.FILE variables 

upon opening, which may lead to the incorrect display of text information. In such 

cases, you should use Microsoft Word for viewing Word files. 

 

7.1 How to insert PRO.FILE variables into a Word document? 

The integration PRO.FILE – Word enhances this functionality by the option to display 

data from the document description in PRO.FILE in your Word document as variables. 

Upon each update of the document, this data is loaded directly from the PRO.FILE 

document description and displayed in the document. 

To insert PRO.FILE variables into a document proceed as follows: 

1. Place the cursor at the position in your Word document where the variable is to be 

inserted. 

2. Select the function "Variables" => "Edit variables" from the PRO.FILE menu in 

Word. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Variables" => "Edit variables" 

 

Step by step: 
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 The list for the selection of the desired 

information from PRO.FILE is displayed.  

 

Here you can find all information from the 

document description. 

 

The list displays the field titles as well as 

the corresponding data. 

3. Select the document variables to be 

inserted into your Word document: 

 by double-clicking on the desired 

variable, 

 by selecting several variables and the 

function "Add" in the menu of the 

variable window. 

 

4. Once you have inserted all desired variables, you can close the window. 

 The desired PRO.FILE information is now displayed in the Word document. 

 

To update the PRO.FILE variables, select the function "Refresh" from the integration 

menu, as described in the following chapter "How to update PRO.FILE variables in a 

document?". 
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7.2 How to update PRO.FILE variables in a document? 

PRO.FILE variables display information from the PRO.FILE document description in the 

corresponding Word document. 

If the information in the PRO.FILE document description is changed, the PRO.FILE 

variables in the document must be updated. The updated information is then displayed 

in the Word document. 

For this purpose, the function "Refresh" is available in the integration menu. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Variables" => "Refresh" 

 

When this function is selected, all PRO.FILE variables used in the Word document are 

synchronized with the current information from the document description. 

 

 

Note: Update in the master document 

The function "Variables" => "Refresh" only refreshes the variables contained in the 

master document. In order to update variables contained in the sub-documents, all 

documents have to be closed and opened again. For this, the function "Refresh 

document" has to be used. 

 

7.3 How to delete PRO.FILE variables from a document? 

PRO.FILE variables can be deleted manually in Word.  

Furthermore, an overview is available listing the used PRO.FILE variables according to 

the document sections in which they are used. If a variable occurs several times within a 

document, this function offers a quicker way of removing the variable from all places in 

the document. 

1. Selection the function "Edit variables" from the PRO.FILE menu in Word. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "Edit" => "Variables" => "Edit variables" 

 

Proceed as 

follows: 
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 The window for the selection of the 

PRO.FILE variables to be removed 

from the document is displayed in 

the right-hand pane of Word. 

2. Go to the tab "Remove variables". 

3. The list contains the used PRO.FILE 

variables according to the 

document sections in which they 

are used. 

 

 

4. Select the variable you want to remove. Please note: 

 If you have selected "All pages" in the left-hand column, the selected variable is 

removed from all pages on which it occurs. 

 If you have selected a specific page, the selected variable is only removed 

from this page. 

5. Click on "Delete". 

 The variable is now removed. 

You can now select further variables for removal. Once all desired variables are 

removed, you can close the variables pane. 

 

7.4 Tips and tricks: Creating a document template with PRO.FILE 

variables 

The usage of PRO.FILE variables is especially useful for template documents with pre-

defined fields for the display of PRO.FILE information: 

 PRO.FILE variables are inserted in a document. The document is then saved in 

PRO.FILE. 

 If a new document is created on the basis of this template, all information from the 

document description is automatically updated in the new document. 

All PRO.FILE information from the template is already in the new document and 

updated with data from the new document description. 

An example would be the title page of this manual in the PDF version: 

 

 A document 

template for 

manuals is 

saved in 

PRO.FILE. 

 

 

Advantage:  

Example: 
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 For this template, different information (manual name, release month, release year, 

…) is saved in the document description. 

 

 This information is also displayed on 

the front page of the Word 

document.  

 

However, it is not entered manually 

there, but inserted as a PRO.FILE 

variable.  

 

This way, the manual name, release 

number, release month and release 

year are displayed from the 

document description in PRO.FILE.

  

 

(Compare the document description 

shown above and the manual front 

page on the right). 

 

 Based on this 

template 

document, a 

new document is 

saved in 

PRO.FILE with a 

new document 

description. 
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 If the corresponding Word 

document is now opened, it 

automatically contains the 

information from the document 

description (Compare the 

document description shown above 

and the manual front page on the 

right).  

 

All fields inserted as PRO.FILE 

variables automatically display the 

values from the document 

description in PRO.FILE. 

 If any information in the document 

description (e.g. the release month) 

is changed afterwards, it is 

automatically updated in the Word 

document, when the file is opened 

again. 

 

 

For the creation of a template document template with fields for PRO.FILE variables 

proceed as follows: 

1. Create a new Word document to be used as template for further documents. 

 

 

Note: Variables are only available after saving to PRO.FILE 

In order to work with PRO.FILE variables, the document must be saved to PRO.FILE. If 

the document is not saved in PRO.FILE, there is no connection to any data, and 

therefore, no PRO.FILE variables can be used. 

 

2. Select the function "Save" => "Save as" => "Create" from the integration menu 

and save the document to PRO.FILE. A new document description is thus created.

  

(See chapter ""Save"). 

3. The PRO.FILE connection is now established and you can insert the desired 

variables from the document description into your Word document. Select the 

function "Edit" => "PRO.FILE variables" => "Add variables" from the integration 

menu.  

(See chapter "How to insert PRO.FILE variables into a Word document?"). 

Step by step: 



Operation Integration PRO.FILE - MS Word Multi-Document Tips and tricks: Creating a document template with 

PRO.FILE variables 

PRO.FILE Release 8.7 
July 2017 Page 62 of 86 

4. Once all variables are inserted, you have to save your changes to the document 

again to PRO.FILE. Select the function "Save" => "Save" from the integration menu. 

You can now close the document. 

 The template document with the PRO.FILE variables is now available in PRO.FILE. 

5. To create a new document based on the template, select the function "New" from 

the integration menu. 

6. Select the document to be used as template. 

7. You can then fill in the document description for the new document and save it to 

PRO.FILE.  

(See chapter ""New from template" "). 

 The new document is now opened in Word "for editing". 

 All PRO.FILE variables are now already filled with values from the new document 

description. 

 If the values need to be refreshed manually (e.g. because changes to the document 

description have been made while the Word document was opened) you can use 

the function "Edit" => "PRO.FILE variables" => "Refresh variables" from the 

integration menu. 

 



Operation Integration PRO.FILE - MS Word Multi-Document Tips and tricks: Creating a document template with 

PRO.FILE variables 

PRO.FILE Release 8.7 
July 2017 Page 63 of 86 

8 Insert the modification list from PRO.FILE 

Via the function "Modification list" => "Insert" the modification list from PRO.FILE can 

be inserted into the Word document. Depending on the PRO.FILE configuration various 

actions (e.g. the editing of a file in a specific status or the creation of a version/revision) 

cause the prompting for a modification list entry. Such entries can also be added, edited 

or deleted manually. 

 

In order to use the modification list in PRO.FILE, the fields of the modification list have 

to be configured in the Form Designer of the PRO.FILE Management Console. 

Furthermore, the positions of the table headings can be specified and formatted. For 

more details, see the manual "Installation and Administration Integration PRO.FILE MS 

Word Multi Document" or contact your administrator. 

 

1. Open the Word document from PRO.FILE. 

2. Select the function "Modification list" => "Insert". 

 The modification list is inserted in the Word document. 

 

To update the modification list in the document you can either: 

 open the Word file 

 select the function "Modification list" => "Refresh" 

 

  

Configuration 

required 

Proceed as 

follows 
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8.1 Change the column headings 

When the modification list is inserted, the properties defined for the specified fields via 

the Form Designer in the PRO.FILE Management Console are applied to the table. You 

can edit these table headings. 

 

1. In Word, go to "File" => "Info" => "Properties" => "Advanced Properties". 

 

2. Go to the tab "Custom". 

 

3. From the "Properties" list, select the property name you want to change. 

4. Enter the new column heading into the field "Value". 

5. Apply your change with <Modify>. 

6. Close the dialog with <OK>. 

7. Go to the PRO.FILE integration menu and select the function "Modification list" => 

"Refresh". 

 The new column headings are displayed in the modification list table. 

Proceed as 

follows 
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8.2 Delete the modification list 

To delete the modification list from the Word document, please use the integration 

function, in order for all affected document properties to be properly removed from the 

document. 

Select the function "Modification list" => "Delete" from the integration menu. 

 The modification list is removed from the Word document. 

 The field properties of the modification list are removed from the document as well. 

 

 

Note: 

If the modification list is not removed via the integration function, this may lead to error 

messages due to remaining but defunct document properties. These properties then 

have to be removed manually. 
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9 Creation and administration of serial letters 

The PRO.FILE Office XP Integration enables the administration of serial letter documents 

and data sources via the PRO.FILE data base.  

Serial letters and Excel data sources can be stored in PRO.FILE and can be used 

separately for creating new serial letter documents.  

There are different options: 

 A new serial letter can be stored in PRO.FILE. If the serial letter contains a new 

Word data source or a Word data source not already stored in PRO.FILE, the data 

source is stored in PRO.FILE, too.  

 Already existing serial letter documents can be retrieved from PRO.FILE for editing. 

By retrieving the document, the linked Word data source is retrieved, too and is 

made available for the serial letter document. 

 A new serial letter can be created in Word and can be linked to an already existing 

Excel data source in PRO.FILE.  

 You can change or remove a data source assigned to the document. The link in 

PRO.FILE is disconnected and the serial letter function of Word is deactivated.  

 

 

Note: 

Only Excel data sources can be used as data sources for serial letters with the 

PRO.FILE Word Integration VSTO. The usage of ODBC, WORD, ACCESS or SQL data 

sources is not possible with the Office Integration. 

 

Detailed information on the on the work with serial letters via the PRO.FILE – Word 

integration can be found in the following chapters: 

 Basic explanations for the usage of serial letters in PRO.FILE 

 Creating and Saving a new serial letter in PRO.FILE 

 Opening a serial document from PRO.FILE 

 Linking of Excel data sources from PRO.FILE to a new serial document 

 Removing a data source from a serial letter 

 

  



Operation Integration PRO.FILE - MS Word Multi-Document Basic explanations for the usage of serial letters in PRO.FILE 

PRO.FILE Release 8.7 
July 2017 Page 67 of 86 

9.1 Basic explanations for the usage of serial letters in PRO.FILE  

For the administration of serial letters in PRO.FILE it is necessary to know that always 

two Word documents are used when working with a serial letter in MS Word.  

 The main document contains the fields, in which the data for serial printing is 

inserted and via which the individual copies of the relevant data records are 

displayed. It also contains general information, which is the same in all copies of 

the serial document, e.g. "Dear Sirs".  

 The second document is the Excel data source. This source contains the 

information which is different in each copy of a serial printing document. A data 

source contains for example the names and addresses of all recipients of a serial 

letter.  

 PRO.FILE stores both files under different data records. When storing and creating 

a new serial document in PRO.FILE, a document record for the respective Excel 

data source automatically has to be created. 

 Alternatively, when creating a new serial print document, a link to an already 

existing Excel data source in PRO.FILE can be established.  

 When retrieving an already existing serial print document from PRO.FILE, PRO.FILE 

identifies the link between the main document and the respective data source. The 

data source will be opened automatically to make the contained data available for 

serial printing. 

 

9.2 Creating and Saving a new serial letter in PRO.FILE 

Creating a new serial letter and saving to PRO.FILE takes place in two steps. 

 Step 1: The serial letter document is created in Word.   

For this, either a new data source is created in Word or an already existing data 

source from PRO.FILE is embedded. 

 Step 2: The serial letter document is saved in PRO.FILE.   

In case of the new creation of an Excel data source this source is saved in 

PRO.FILE, too. This saving process is triggered automatically. 

 

To create a new serial letter in Microsoft Word, proceed as follows: 

1. Create a document in Microsoft Word which contains general information that will 

be the same in all copies of the serial letter (e.g. Dear Madam or Sir). For more 

information refer to the Microsoft Word online help. 

2. The data source now has to be embedded for filling out the data fields in the 

individual serial letters. In this data sources e.g. names and addresses of the 

recipients of serial letters are stored. You can  

 create a new data source or  

 assign an already existing data source from PRO.FILE to the serial letter 

document. 

 

Step 1: The 

creation of a new 

serial letter in 

PRO.FILE 
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Note: 

Only Excel data sources can be used as data sources for serial letters with the 

PRO.FILE Word Integration VSTO. The usage of ODBC, WORD, ACCESS or SQL data 

sources is not possible with the Office Integration. 

 

3. Insert now the desired serial print fields in your main document. These serial print 

fields serve as placeholders in the finished serial letter, as they indicate the place at 

which the data from the data source is inserted into the respective copies of the 

serial letter. 

4. Finally, the data of the word data source has to be linked to the main document. 

Each data record in the Excel data source results in one copy of the serial letter. 

 

To save a serial letter in PRO.FILE, proceed as follows: 

5. Make sure that the main serial printing document containing the serial print fields is 

active in Word. 

6. Use the command "Save" in the menu "PRO.FILE" in the Word menu bar. 

7. Save the serial document master:  
The Checkin Wizard is displayed prompting you to fill in the document description 

for the serial document master.  

(See chapter "Saving a document to PRO.FILE"). 

8. Confirm your document description data with <Next>. 

9. The dialog for the selection of a project is displayed. In this dialog you can assign 

the new document description to a project. 

 To assign the document to a project, select the project and click <Next>. 

 If you do not want to assign the document to a project, click <Skip>. 

 

 

Note: Project assignment 

By default, the Checkin wizard offers the dialog for a project assignment. If this dialog 

is not displayed, this may be because 

 you do not have the permission to access projects, or 

 the administrator has deactivated this feature. 

Further information can be found in the manual "Installation and Administration of the 

Integration PRO.FILE – Office". 

 

  

Step 2: Saving a 

serial letter in 

PRO.FILE: 
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10. Save Excel data source:  

PRO.FILE now checks, whether an Excel data source, that has not yet been saved to 

PRO.FILE, exists for this serial letter document.  

If this is the case, the Checkin wizard is displayed. You now have the possibility to 

create a document description for the linked Excel data source (see chapter 

""Save"). 

11. Confirm your document description input with <Next>. 

12. The dialog for the selection of a project is displayed. In this dialog you can assign 

the document description of the Excel data source to a project. 

 To assign the document to a project, select the project and click <Next>. 

 If you do not want to assign the document to a project, click <Skip>. 

 

 

Attention: Saving with Office 2010/2013 – Excel file has to be open 

If you are using Office 2010 or 2013, the Excel file must be open as well when the 

serial letter document in Word is saved to PRO.FILE. 

Only if the Excel data source is open at the same time, the Word document can be 

saved to PRO.FILE. 

 

The files are now stored in PRO.FILE and the respective links are established in the 

PRO.FILE database to clearly link the data source with the Word serial document. The 

Word serial document is opened in Word "for editing". Both document descriptions are 

saved in PRO.FILE. 

 The saving of the serial main document and the Excel data source is now finished. 

 

9.3 Opening a serial document from PRO.FILE 

A serial document from PRO.FILE is opened in Word via the function "Open" => 

"Open" from the integration menu.  

 

 

Function call: 

"PRO.FILE" => "Open" => "Open" 

 

A serial document is opened the same way as a normal document. For further 

information see chapter "Opening documents from PRO.FILE". 

 

When opening a serial document from PRO.FILE "as copy" or "for editing", PRO.FILE 

automatically checks out the Microsoft Excel data source linked to the serial letter and 

supervises it.  

Opening the data 

source 
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If the serial letter document is retrieved "for editing", both the Word document and the 

Excel data sources are locked in PRO.FILE for other users. 

 

9.4 Removing a data source from a serial letter 

You have opened a serial letter from PRO.FILE in Word, to which a data source (also 

saved in PRO.FILE) is assigned. 

If you want to remove this data source, proceed as follows: 

1. Select the function "Remove data source" from the integration menu.  

 

 

Function call: 

PRO.FILE" => "Edit" => "Mail merge" => "Remove data source" 

 

2. The PRO.FILE – Word integration displays a dialog asking whether the data source 

is really to be removed from the Word document. 

3. Confirm the query with <Yes>. 

 The connection in PRO.FILE between the serial letter document and the data source 

is removed. The serial letter no longer has a data source assigned. 

See the following chapter on how to link a new data source from PRO.FILE to your serial 

letter document: Linking of Excel data sources from PRO.FILE to a new serial document. 

 

9.5 Linking of Excel data sources from PRO.FILE to a new serial 

document  

Access to stored Microsoft Word data sources in PRO.FILE when creating a new serial 

letter is made in two steps: 

 First, the serial letter document is created in Word. A main document is created in 

Word containing the general information which is to be the same in all copies of 

the serial letter (e.g. "Dear Sirs"). For help, refer to the online help in Microsoft 

Word. 

 In the second step the data source has to be stored containing the information for 

filling in the data fields of the individual serial letters.  

 

 

Note: 

Only Excel data sources can be used with the PRO.FILE Office Integration as data 

sources. ODBC, WORD, ACCESS, or SQL data sources are not supported. 
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Function call: 

"PRO.FILE" => "Edit" => "Mail merge" => "Insert data source" 

 

1. Make sure that the main serial printing document containing the serial printing 

fields is active in Word. 

2. Select the function "Insert data source" from the integration menu. The PRO.FILE 

surface appears.  

3. The Checkout wizard prompts you to select the existing Excel data source, which 

should be linked to the serial print document. Select the desired Excel document 

and click <Open>. (See chapter "Quick selection: The PRO.FILE Checkout 

Wizard"). 

4. In the Word dialog that is now displayed select the desired tab of the Excel file 

containing the serial letter data. Please also specify whether the table has columns 

headings or not.  

Confirm your selections with <OK>. 

5. The data source is now linked to the serial printing document. The linking in the 

document structure is noted and controlled in PRO.FILE. 

The tool bar/tab "serial print" is now activated in Microsoft Word. You can now place 

the serial printing fields defined in the data source within the Word document. You can 

now use the respective Word functions to complete your serial printing document. 

 

Proceed as 

follows: 
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10 Subdocuments: How to link documents 

The integration PRO.FILE – MS Word Multi Document supports the functionality of 

master documents and subdocuments in MS Word. 

With this, a document A can be linked in a document B. The document B thus becomes 

the master document, document A becomes a subdocument within the master 

document B. Furthermore, it is possible to link a larger number of subdocuments in the 

master document. 

This results in a master document, the contents of which reference to other documents. 

Changes to a subdocument are also updated in the master document, in which the 

subdocument is "assembled" and linked. 

The structures are managed and updated in PRO.FILE. 

 

 

Attention when using different Word versions 

In order to avoid problems with different Word versions and their file formats when 

working with master documents and subdocuments, it is strongly recommended to 

build subdocument structures only with a homogenous Word environment and office 

formats of the same Word version (e.g. Word 2013). 

 

10.1 Insert subdocument 

The function "Subdocuments" => "Insert" is used to link Word documents from 

PRO.FILE as subdocuments in a master document. 

Linked subdocuments reference to a Word document in PRO.FILE. If this original 

document of the linked subdocument is updated, the changes are also updated in the 

master document. If the subdocument is used in several master documents, the update 

is made in each master document. 

PRO.FILE administrates the master document and the linked subdocuments as separate 

documents and monitors the link structures resulting from the linking of these files. If the 

master document is opened from PRO.FILE, the linked subdocuments are called from 

PRO.FILE and displayed in the master document. 

 

 

Function call: 

"PRO.FILE" => Group "Subdocuments" => "Insert" 
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1. Place the cursor at the position in your document, where the 

document from PRO.FILE is to be inserted as subdocument. 

 

 

2. Go to the "PRO.FILE" tab in Word and select the function "Insert" from the group 

"Subdocuments". 

 The PRO.FILE Checkout Wizard "Select document is displayed. 

3. Select the document description of the desired PRO.FILE object (Further information 

on the opening of files from PRO.FILE can be found in the chapter "Quick 

selection: The PRO.FILE Checkout Wizard"). 

4. Click on <Open>. 

 The selected file is now linked as subdocument at the cursor position in the master 

document. It is thus not a part of the master document but only referenced by it. 

Changes to the Word document of the subdocument are updated in the master 

document when the references are updated. PRO.FILE handles and monitors the 

linking of the document structure 

 

 

Note: Section breaks 

Make sure that section breaks in Word are set to "Continuous". You can find this 

setting in the Word menu "Page layout" in the area "Page setup". Click on the arrow at 

the bottom right corner to get to the "Page setup" window. On the tab "Layout" you can 

adjust the setting above. 

In the sub-document, you should avoid section breaks at the beginning and the end of 

the file, since Word will take over these breaks into the master document, thus 

affecting the page layout of the overall document. 

 

By the linking of documents as subdocument and master document via the PRO.FILE – 

MS Word Multi Document integration, a structure is built among these files. 

To display this structure, e.g. to get an overview of documents linked in the master 

document, the following functions are available: 

 In the menu of the integration: in the group "View" => "Document" => 

"Document structure", 

 in PRO.FILE:  

 via the function "View" => "Browser", 

 via the dependent tabs "Browser" (view from master document downward) and 

"Where used" (view from subdocument upward). 

 

  

Proceed as 

follows: 

Displaying the 

resulting structures 
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10.2 Refresh document 

Via the function "Refresh document", a master document with the linked subdocuments 

is closed in MS Word, saved in PRO.FILE and opened anew with the updated 

subdocuments from PRO.FILE in MS Word. 

The corresponding processes are described in the chapters "Saving a document to 

PRO.FILE" and "Opening documents from PRO.FILE". 

 

10.3 Remove sub-document 

In order to remove sub-documents, you can use the corresponding Word functions. 

First, activate the "Outline" mode from the "View" tab. 

 "Show document": If this function is activated, a frame is displayed around the 

linked sub-document. 

 "Collapse subdocuments": Shows the contents of the subdocument or the path to 

the file.  

 

There are two ways to remove a sub-document: 

1. If you want to remove the sub-document from the master document, select its text 

and hit the <Del> key. 

2. If you want to make the sub-document part of the master document, click into the 

text of the sub-document and select the function "Unlink". The connection between 

the sub-document and the master document is thus removed. 

 

Preparation: 
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11 "View" PRO.FILE information 

The sub-menu "View" of the integration menu contains 

functions for displaying current information on your 

document in PRO.FILE.  

 

The following functions for displaying information are 

available: 

 View "Document form" 

 View "Document structure 

 

 

 

Note: Only available after saving to PRO.FILE 

Since the functions relate to information from the PRO.FILE document description, the 

functions of the group "View" are only available after the document has been saved to 

PRO.FILE. For saving a document, see chapter "Saving a document to PRO.FILE". 

 

11.1 View "Document form" 

If the current Word document is already saved in PRO.FILE, you can use the function 

"Document form" to display the document description in PRO.FILE. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => group "View" => "Document" => "Document form" 

 

To display the document form proceed as follows: 

 Select the function "Document" => "Document form" from the PRO.FILE menu in 

Word. 

 PRO.FILE opens and displays the document form of the current Word document. (If 

PRO.FILE is not already started, a PRO.FILE login may be required first.) 
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11.2 View "Document structure" 

By linking OLE objects and graphics from PRO.FILE into your document the current 

document obtains a structure of linked objects. To view the structure of your document 

in PRO.FILE, the function "Document structure" is available. 

 

 

Function call from the PRO.FILE menu in MS Word: 

"Tab "PRO.FILE" => group "View" => "Document" => "Document structure" 

 

To display the document structure in PRO.FILE, proceed as follows: 

 Select the function "Document" => "Document structure" from the PRO.FILE menu 

in Word. 

 PRO.FILE opens and displays the document structure of the current Word 

document. (If PRO.FILE is not already started, a PRO.FILE login may be required 

first.) 
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12 Extras, information and help 

Via the section "Extras" from the PRO.FILE menu in 

Word, you can access the PRO.FILE online help, current 

information on PROCAD, the PRO.FILE Workcenter and 

information on the software status of the integration. 

See the following sub-chapters: 

 

 

 "Help" for your PRO.FILE questions 

 "PROCAD on the web" 

 The "Workcenter" for file management 

 "About" the configuration of the installed integration 

 

12.1 "Help" for your PRO.FILE questions 

To support you with your work with PRO.FILE and the integration, you can access the 

PRO.FILE online help via the integration.  

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => Group "Extras" => "Extras" => "Help" 

 

When the function "Help" 

is selected, the PRO.FILE 

help is displayed in your 

default web browser. 

 The left-hand pane 

displays the structure, 

so that you can 

navigate to the 

chapter relevant for 

you. 

 The information of the 

selected chapter is 

displayed in the right-

hand pane. 
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Within the help screen you can use the following functions: 

 

 

Switch back and forth between the help chapters. 

Contents: Displays the chapter structure. 

Search: Displays the entry field for a search string. The entire help will be 

searched for this string. The results are displayed in the left pane. 

 

The current help chapter is sent to the printer. 

 

 

Note: Access to online help – "local" or via internet 

The PRO.FILE help is either installed at your computer or your company network – or is 

accessed via internet connection from the PROCAD server. The advantage of the latter 

option is that the help is always up to date. 

The address bar of your web browser displays whether the file is accessed locally or via 

the internet. 

 

12.2 "PROCAD on the web" 

Via the menu function "PROCAD on the web" you can directly access the web site of the 

company PROCAD for the latest information regarding PRO.FILE. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => Group "Extras" => "Extras" => "PROCAD on the web" 

 

12.3 The "Workcenter" for file management 

The Workcenter helps you in the administration of files and components loaded from 

PRO.FIL and saved locally. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => Group "Extras" => "Extras" => "Workcenter" 

 

In the Workcenter you can specify a work folder for each project, display these folders in 

the Windows Explorer, lock and unlock components, get information on documents or 

delete individual documents from the work folder. 
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The Workcenter is divided in two areas: 

 On the left-hand side is the folder structure of the Workcenter with the 

corresponding functions. 

 The right-hand side contains status information on the files loaded from PRO.FILE 

and saved locally in the Workcenter along with corresponding functions. 

  

 

 

 The selected folder becomes the current work folder. The current 

workfolder is displayed in bold. 

 
The folder structure view is refreshed. 

 The selected folder is opened in Windows Explorer. This gives you 

the possibility to delete, create or copy a workfolder via the regular 

Windows functions. 

 

  

The Workcenter 

functions 

Functions for the 

folder structure: 
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 Via the drop-down menu you can access the following 

information for selected documents: 

 Part structure  

Part form  

Part usage  

Bill of materials 

Document structure  

Document form  

Document usage 

 
The contents of the selected line are read anew from 

PRO.FILE and displayed. 

 
The corresponding documents is – depending on the 

access rights of the user – locked or unlocked 

 The selected documents are deleted from the folder. 

If the local status of at least one of the selected files is 

newer than the status saved in PRO.FILE, a warning 

message is displayed. 

Files from the Workcenter can also be deleted using the 

<Del> key. 

 This function will delete all files from PRO.FILE that have 

not been changed locally from the current work folder. 

Sub-folders are ignored. 

 
The display filters for the document list can be enabled via 

this icon. The displayed contents can be filtered for each 

column. 

For detailed information see the manual "Operation 

PRO.FILE for Beginners". 

 
Selected files from the work folder can be replaced by a 

newer version of the corresponding file from PRO.FILE. 

Double-click on file in 

Workcenter folder 

Double-clicking a file in the Workcenter folder will open the 

File in Microsoft Word. 

 

  

The functions for 

the work folder 

contents: 
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12.4 "About" the configuration of the installed integration 

For the integration PRO.FILE – Word, your system administrator makes specific 

configuration settings. 

To see the status of this configuration you can use the function "About" from the 

integration menu. 

 

 

Function call from the PRO.FILE menu in MS Word: 

Tab "PRO.FILE" => Group "Extras" => "Extras" => "About" 

 

 If an error occurs during your work 

with the integration, e.g. an error 

with the database access, this 

information can be helpful for your 

administrator. 

 At the same time, you can see the 

database and PRO.FILE installation 

version you are working with. For 

this, the following information is 

displayed: 

 Installation path for PRO.FILE Client 

and PRO.FILE Server 

 

 

 Software status of PRO.FILE and build number of installed PRO.FILE setup 

 Database system used 

 Conversion status of PRO.FILE. 

 PRO.FILE database ID with database name and database computer that is 

accessed. 

 Program version, logged-in user, dictionary language and memory usage. 

 

The information is only displayed and cannot be changed by the user. 

To close the window click <OK>. 

 



Operation Integration PRO.FILE - MS Word Multi-Document Close Word: Save and remove lock? 

PRO.FILE Release 8.7 
July 2017 Page 82 of 86 

13 Close Word: Save and remove lock? 

Once you have finished editing a document you want to close Word – as you are used 

to do. A dialog with two options is to remind you of saving and unlocking your 

document in PRO.FILE: 

 

 You have opened a document from 

PRO.FILE "for editing" and you have 

not yet saved your changes back to 

PRO.FILE? 

 The PRO.FILE integration reminds 

you of saving your changes to 

PRO.FILE: 

 

 

 If you activate the checkbox "Save changes to PRO.FILE?", your changes will be 

saved back to PRO.FILE. The state of the document saved in PRO.FILE is 

overwritten with the current state of your document in Word. 

 If you deactivate the checkbox, your changes will be discarded. Attention, data 

loss: In this case, all changes made since the last saving to PRO.FILE are lost. The 

document remains in PRO.FILE in the last saved state. 

 Witch <Cancel> you can return to editing your document in Word. 

 

Documents that have been opened "for editing" are locked in PRO.FILE. Other PRO.FILE 

users cannot edit the document during this time.  

When you close Word and thus finish the editing of the document, the integration asks 

you, whether the lock is to be removed or not: 

 If you activate the checkbox "Unlock the document in PRO.FILE?", the document is 

unlocked in PRO.FILE. Other users can now also open the document "for editing". 

 If you deactivate the checkbox, the document remains locked in PRO.FILE.  

Example: You want to save your changes to PRO.FILE, but you are not yet finished 

with your changes to the document. In order to stop other users from editing the 

document until you are finished with your changes, the document stays locked and 

thus reserved for you. 

 With <Cancel> you can return to editing your document in Word. 

 

"Save changes to 

PRO.FILE": 

"Unlock the 

document in 

PRO.FILE": 
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14 Functions of the Integration PRO.FILE – Word 

This chapter contains descriptions of functions of the integration PRO.FILE – Word that 

are recurrently required for different actions. 

 

14.1 Quick selection: The PRO.FILE Checkout Wizard 

If you use the function "Open" from the PRO.FILE integration, you have to select the 

document to be opened in the Checkout wizard. 

The aim of this procedure is: 

 For PRO.FILE to know which document is to be opened, the desired document 

description must  

 either be selected in a list view or a structure browser 

 or be displayed in a form view 

 Then the button <Open> at the right bottom of the Checkout wizard has to be 

clicked. 

Prerequisite for the selection/activation of a document in PRO.FILE is that the document 

is displayed in a list or form view. 

 

When the Checkout wizard is opened, the PRO.FILE GUI is displayed as it has been 

used the last time:  

 If search results had 

previously been opened in 

a list or form view in a 

separate tab, you can 

directly access the 

displayed documents.

  

If the desired document is 

displayed on a tab, select 

it and click <Open>.  

 

 If no search had been made previously, or if the desired document is not displayed 

on one of the existing tabs, you can now search for it.  

For this, several functions, which are explained in the following, are available: 
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Attention: Double-click in the Checkout wizard 

Documents are selected and then opened via the <Open> button. A document 

cannot be loaded via a double click! 

Because a double click means: Open document for viewing! 

The checkout will remain active in the background waiting for your selection. But only 

if the checkout wizard is closed, the document can be used for editing in MS Word. 

 

To search for data records in the Checkout Wizard, several options are available: 

 Searching via the tab "Cockpit"  

The same icons as in the icon bar can be found on the tab "Cockpit": "Search" 

=>"Document", "Full-text search", "Search" => "Part", "Search" => "Project" have 

the same function as the icons in the icon bar.  

You can always go back to the tab "Cockpit". 

 

 Search via the functions of the favorites bar  
The favorites bar also offers several ways of searching for a document:  

 Via the "Favorites" memorized searches or data lists can be accessed with a 

double click. 

 With the "SmartSearch" you can create individual search forms. 

 If you are working with PRO.FILE processes and tasks, you can access the 

documents linked to a task or process via the task or process structure. 

 

Detailed information on the selection of data in PRO.FILE can be found in the manual 

"Operation PRO.FILE for Beginners". 

 

Searching for 

data records in 

the Checkout 

Wizard 
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